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1. Η Βασική Οθόνη του MS Project 2019© 

Η οθόνη εκκίνησης του MS Project 2019© (Project) παρουσιάζεται στην κάτωθι εικόνα:  

 

• Η βασική μορφή του προγράμματος, π.χ. μενού τύπου Ribbon, καρτέλες κ.λπ., είναι παρόμοια 

με τα άλλα προγράμματα της Microsoft.  

• Στη βασική προεπιλογή της (Gantt Chart View), η βασική επιφάνεια της οθόνης χωρίζεται σε δύο 

τμήματα μέσω μιας διαχωριστικής γραμμής (Pane divider). Η αναλογία των επιφανειών μπορεί 

να αλλάξει μετακινώντας τη διαχωριστική γραμμή δεξιά - αριστερά.  

• Το αριστερό τμήμα, αποτελεί τον πίνακα εισαγωγής δεδομένων (Entry), όπου εισάγονται όλα τα 

δεδομένα των δραστηριοτήτων του έργου, όπως όνομα, διάρκεια, έναρξη, λήξη, σχέσεις 

αλληλουχίας, πόροι, κόστος, κ.λπ.  

• Η 1η στήλη του πίνακα εισαγωγής δεδομένων, αποκαλούμενη ως στήλη δεικτών (Indicators), 

απεικονίζει πληροφορίες, μέσω συμβόλων, για τις δραστηριότητες που έχουν καταχωρηθεί, 

όπως σημειώσεις, υπερσυνδέσεις με άλλα αρχεία, κ.ά.  

• Στη στήλη Task Mode (2η στήλη του πίνακα εισαγωγής δεδομένων), απεικονίζεται ο τρόπος 

προγραμματισμού των δραστηριοτήτων, αυτόματος ή χειροκίνητος από το χρήστη.  

• Στο αριστερά κάτω τμήμα της οθόνης, υπάρχει ο διακόπτης ρύθμισης αυτόματου/χειροκίνητου 

χρονοπρογραμματισμού νέων δραστηριοτήτων. Ανάλογα με τη ρύθμιση αυτού του διακόπτη, η 

νέα δραστηριότητα που εισάγεται τίθεται είτε σε αυτόματο είτε σε χειροκίνητο προγραμματισμό.  

• Στο δεξιό τμήμα της οθόνης, η προεπιλεγμένη προβολή είναι αυτή του διαγράμματος Gantt και 

του ημερολογίου του έργου.  

• Στο βασικό τμήμα της οθόνης, υπάρχει η δυνατότητα προβολής και άλλων γραφημάτων πέραν 

του διαγράμματος Gantt, όπως π.χ. του κομβικού γραφήματος του έργου (Network Diagram). Η 

ρύθμιση της προβολής γίνεται από το μενού Gantt Chart View που βρίσκεται στο αριστερό πάνω 

τμήμα της οθόνης.  

• Το Help του λογισμικού είναι διαθέσιμο επιλέγοντας τη σχετική καρτέλα από το βασικό μενού 

(μεταξύ View και Format). Για τη λειτουργία του Help απαιτείται σύνδεση στο διαδίκτυο. 

• Το όνομα του ανοιγμένου αρχείου (π.χ. Project1) προβάλλεται στο μέσο του άνω τμήματος της 
οθόνης.  
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2. Χρονικός Προγραμματισμός 
2.1. Παράδειγμα #01: 

Οι περιορισμοί διαδοχής και οι εκτιμώμενες διάρκειες (σε εβδομάδες) των δραστηριοτήτων ενός 

έργου φαίνονται στον Πίνακα Α: 

Πίνακας Α – Περιγραφή δραστηριοτήτων, σχέσεις αλληλουχίας και εκτιμώμενες διάρκειες 

Α/Α Δραστηριότητα 

Αμέσως 

προηγούμενες 

δραστηριότητες 

Εκτιμώμενη 

διάρκεια 

(εβδομάδες) 

1 A --- 3 

2 B Α 4 

3 C B 3 

4 D Β 10 

5 E D 8 

6 F D 4 

7 G D 6 

8 H C, E, F, G 8 

9 I H 5 

10 J H 5 

11 K I 4 

12 L J 2 

13 M K, L 4 

 

Η ημερομηνία έναρξης του έργου είναι η 03/01/2022. Ζητούνται με χρήση του λογισμικού MS Project©: 

(α)  ο πίνακας των μεγεθών χρονικού προγραμματισμού του έργου: ενωρίτερης και βραδύτερης 

έναρξης, ενωρίτερης και βραδύτερης λήξης και ολικού περιθωρίου, καθώς και ο εντοπισμός 

των κρίσιμων δραστηριοτήτων και της κρίσιμης διαδρομής του έργου, 

(β)  το διάγραμμα Gantt για την ενωρίτερη έναρξη των δραστηριοτήτων και 

(γ)  η σχεδίαση του κομβικού δικτυωτού γραφήματος του έργου. 

 

2.2. Αναλυτική Επίλυση Παραδείγματος #01: 

Με την εκκίνηση του προγράμματος, ανοίγει ένα νέο (κενό) έργο στην προεπιλεγμένη προβολή του 

διαγράμματος Gantt (Gantt Chart View). Αρχικά, πρέπει να ρυθμιστεί η επιλογή «αυτόματος/ 

χειροκίνητος χρονοπρογραμματισμός νέων δραστηριοτήτων» (κάτω αριστερά στην οθόνη), από την 

προεπιλεγμένη χειροκίνητη λειτουργία (New Tasks: Manually Scheduled) στην αυτόματη λειτουργία 

(New Tasks: Auto Scheduled), έτσι ώστε οι δραστηριότητες του έργου που θα εισαχθούν στη 

συνέχεια να προγραμματιστούν αυτόματα. Οι δύο προαπαιτούμενες ρυθμίσεις για την εισαγωγή των 

δραστηριοτήτων του έργου είναι: 

Καθορισμός των ιδιοτήτων του έργου (Project Properties ► Project Information) 

Ανοίγει το παράθυρο διαλόγου (βλ. επόμενη σελ. 5) Project Information (Πληροφορίες Έργου). Τρεις 

προεπιλεγμένες ρυθμίσεις θα πρέπει υποχρεωτικά, είτε να επιβεβαιωθούν ή να τροποποιηθούν: η 

μέθοδος προγραμματισμού των δραστηριοτήτων (Schedule from), το ημερολόγιο έργου (Calendar) 

και η προτεραιότητα των δραστηριοτήτων (Priority). To έργο μπορεί να προγραμματιστεί, είτε από την 

ημερομηνία έναρξης (Project Start Date) μέχρι την ολοκλήρωσή του, είτε με βάση την ημερομηνία 

λήξης του (Project Finish Date). Για παράδειγμα, οι δραστηριότητες μπορούν να προγραμματιστούν 

από την 03/01/2022 και μετά, ή να ξεκινήσουν από κάποια μεταγενέστερη ημερομηνία και να 

προγραμματιστούν προς τα πίσω. Δεν δύναται πάντως να καθοριστούν ταυτόχρονα και οι δύο 

ημερομηνίες προγραμματισμού. 
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Η ημερομηνία έναρξης (Project Start Date) είναι η προκαθορισμένη επιλογή έτσι ώστε όλες οι 

δραστηριότητες του έργου να ξεκινούν το συντομότερο δυνατό. Με την επιλογή της ημερομηνίας 

ολοκλήρωσης (Project Finish Date), οι δραστηριότητες ξεκινούν όσο το δυνατόν πιο αργά. Η 

προεπιλογή για το ημερολόγιο έργου (Calendar) είναι η βασική (Standard). Η ρύθμιση Priority 

(προτεραιότητα) χρησιμοποιείται για τον καθορισμό της προτεραιότητας του τρέχοντος έργου σε 

σχέση με άλλα έργα που αντλούν πόρους από κοινή δεξαμενή πόρων. Η προκαθορισμένη τιμή είναι 

500 ενώ οι τιμές μπορούν να κυμαίνονται από 0 έως 1000. 
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Καθορισμός του εργάσιμου χρόνου (Project Properties ► Change Working Time) 

Ανοίγει το παράθυρο διαλόγου Change Working Time (αλλαγή εργάσιμου χρόνου) της σελ. 5. Η 

προεπιλογή για το ημερολόγιο του έργου είναι το βασικό ημερολόγιο (Standard). Οι προκαθορισμένες 

εργάσιμες ημέρες και ώρες του βασικού ημερολογίου είναι από 8 το πρωί έως 12 το μεσημέρι και από 

1 το μεσημέρι μέχρι 5 το απόγευμα (οκτάωρο με μία ώρα διακοπή το μεσημέρι), Δευτέρα έως 

Παρασκευή, 52 εβδομάδες το χρόνο. 

 

Η εισαγωγή δραστηριοτήτων γίνεται με κλικ στο πλαίσιο κειμένου Task Name (όνομα δραστηριότητας) 

και πληκτρολόγηση του ονόματος της δραστηριότητας. Εναλλακτικά, μπορεί να γίνει με αντιγραφή και 

επικόλληση από κατάλογο που έχει δημιουργηθεί σε υπολογιστικό φύλλο ή σε επεξεργαστή κειμένου. 

Για το έργο του Παραδείγματος #01 θα πρέπει να εισαχθούν οι δεκατρείς (13) δραστηριότητες του 

Πίνακα Α. Με κάθε εισαγωγή δραστηριότητας, εφόσον έχει ρυθμιστεί o αυτόματος προγραμματισμός και 

η εβδομάδα (βλ. παράθυρο διαλόγου Project Options) ως επιλογή της χρονικής διάρκειας των 

δραστηριοτήτων (File ► Project Options ► Schedule ► Scheduling options for this project ► Duration 

is entered in: Weeks), το λογισμικό θέτει ως διάρκεια δραστηριότητας την εβδομάδα (1 week). Το όνομα 

της δραστηριότητας του επιπέδου (0), λαμβάνεται αυτόματα από το αποθηκευμένο όνομα του αρχείου 

(example-01). Η προεπιλεγμένη ονομασία μπορεί να αλλάξει ως εξής: αφού έχει επιλεχθεί η εν λόγω 

δραστηριότητα, στην καρτέλα Task, με κλικ στο κουμπί Information και στο παράθυρο Summary Task 

Information που εμφανίζεται, εισάγεται το νέο όνομα στο πεδίο Name της καρτέλας General. 

Εναλλακτικά, το παράθυρο Summary Task Information εμφανίζεται πατώντας διπλό κλικ πάνω στο 

όνομα της δραστηριότητας. 
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Στην παρούσα φάση, όλες οι εισαχθείσες δραστηριότητες είναι στο επίπεδο (1) της ιεραρχικής δομής. 

Υπενθυμίζεται ότι, ως επίπεδο (0) ορίζεται το συνολικό έργο. Προαιρετικά, μπορεί να προβληθεί η 

αρίθμηση των δραστηριοτήτων βάσει της ιεραρχικής δομής που δημιουργήθηκε, καθώς επίσης και το 

επίπεδο (0) αυτής, το οποίο (όπως προαναφέρθηκε) αντιστοιχεί στο συνολικό έργο, εφόσον στην 

καρτέλα Format έχει γίνει η επιλογή των πεδίων Outline Number και Project Summary Task. Στη 

συνέχεια, ενεργοποιείται μόνο το πεδίο Project Summary Task. 

 

Εισάγοντας τα δεδομένα που αφορούν στις δραστηριότητες του έργου, τις εκτιμώμενες διάρκειες (στη 

στήλη Duration), τις σχέσεις αλληλουχίας (στη στήλη Predecessors) και θέτοντας ως έναρξη του 

έργου την 03/01/2022, πενθήμερη δραστηριότητα και ωράριο δραστηριότητας το οκτάωρο, η οθόνη 

του Project θα είναι παρόμοια με την επόμενη εικόνα. Με επισήμανση κίτρινου χρώματος (στο 

υπολογιστικό φύλλο) και κόκκινου χρώματος (στο διάγραμμα Gantt) προβάλλονται οι κρίσιμες 

δραστηριότητες (View ► Data ► Highlight: Critical). 

 

Προβάλλοντας τα υπολογισθέντα μεγέθη του χρονικού προγραμματισμού για το έργο (View ► Tables 

► Schedule), η οθόνη του Project θα είναι παρόμοια με την ακόλουθη εικόνα: 
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Η προβολή στη 2η στήλη των διαρκειών των δραστηριοτήτων (Duration) δεν γίνεται αυτόματα. Για να 

προστεθεί η στήλη με την πρόσθετη επιθυμητή πληροφορία, γίνεται δεξί κλικ στην επικεφαλίδα της 

επόμενης στήλης (εδώ η Start). Στην καρτέλα που εμφανίζεται, επιλέγεται Insert Column και από το 

drop down μενού που εμφανίζεται, επιλέγεται Duration. Αντίστοιχα, για να σβηστεί η στήλη επιλέγεται 

Hide Column. Από τα υπολογισθέντα μεγέθη χρονικού προγραμματισμού, εκτός των άλλων 

πληροφοριών, προκύπτει ότι η συνολική διάρκεια του έργου είναι 46 εβδομάδες και η ημερομηνία 

ολοκλήρωσής του (χωρίς να έχουν εισαχθεί ακόμη οι πόροι του έργου) είναι η 18/11/2022. 

Τέλος, για να προβληθεί το κομβικό δικτυωτό γράφημα (Network Diagram) του έργου, από την 

καρτέλα View επιλέγεται Task Views και Network Diagram: 
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3. Οικονομικός Προγραμματισμός & Εξομάλυνση Πόρων  

3.1. Παράδειγμα #02: 

Ως ημερομηνία έναρξης του έργου έχει ήδη ορισθεί η 03/01/2022. Εφαρμόζεται η πενθήμερη εργασία 

ανά εβδομάδα και το οκτάωρο ημερήσιο ωράριο δραστηριότητας. Άλλες αργίες, πλην Σαββάτου και 

Κυριακής, δεν λαμβάνονται υπόψη. Ο Πίνακας Β απεικονίζει το εκτιμώμενο απαιτούμενο εργατικό 

δυναμικό (ανθρώπινοι πόροι) ανά δραστηριότητα. Το κόστος για κάθε εργάτη είναι €350,00 ανά 

εβδομάδα (ή αλλιώς €70,00 ανά ημέρα). Μέγιστο όριο διαθεσιμότητας στους εργάτες δεν υφίσταται. 

Πίνακας Β – Εκτιμώμενοι απαιτούμενοι εργάτες ανά δραστηριότητα 

Α/Α Δραστηριότητα 

Απαιτούμενοι 

Εργάτες ανά 

εβδομάδα 

1 A 2 

2 B 4 

3 C 2 

4 D 9 

5 E 5 

6 F 3 

7 G 3 

8 H 6 

9 I 2 

10 J 4 

11 K 2 

12 L 2 

13 M 3 

 

Επίσης, για την εκτέλεση των δραστηριοτήτων θα χρησιμοποιηθούν τρεις διαφορετικοί τύποι 

μηχανημάτων (μηχανικοί πόροι) M1, M2 και M3. Το κόστος χρήσης τους ανά εβδομάδα είναι 

€250,00, €500,00 και €800,00, αντίστοιχα. Ο μέγιστος διαθέσιμος αριθμός των μηχανημάτων M1, M2 

και M3 είναι τρία (3), τρία (3) και δύο (2), αντίστοιχα, για όλη τη διάρκεια του έργου. Στον Πίνακα Γ 

δίδεται ο εκτιμώμενος απαιτούμενος αριθμός των μηχανημάτων M1, M2 και M3 ανά δραστηριότητα: 

Πίνακας Γ – Εκτιμώμενος απαιτούμενος αριθμός των πόρων M1, M2 και M3 ανά εβδομάδα 

Α/Α Δραστηριότητα 

Μηχάνημα 

(αριθμός ανά εβδομάδα) 

Μ1 Μ2 Μ3 

1 A 2 1 1 

2 B --- 1 2 

3 C 1 --- 1 

4 D --- 1 2 

5 E 2 2 --- 

6 F 1 2 --- 

7 G 2 --- 1 

8 H 3 --- --- 

9 I 1 3 1 

10 J --- 1 --- 

11 K 1 1 2 

12 L --- 2 --- 

13 M 3 --- --- 
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Για την υλοποίηση του έργου απαιτούνται τα υλικά Υ1 και Υ2. Η προμήθεια του υλικού Υ1 κοστολογείται 

σε €300,00/τ.μ. (τετραγωνικό μέτρο) ενώ του υλικού Υ2 σε €20,00/μ.μ. (μέτρο μήκους). Στον Πίνακα Δ 

δίδονται οι απαιτούμενες ποσότητες των υλικών Y1 και Υ2 ανά δραστηριότητα: 

Πίνακας Δ – Εκτιμώμενες απαιτούμενες ποσότητες των υλικών Y1 και Y2 ανά δραστηριότητα 

Α/Α Δραστηριότητα 

Ποσότητες 

Υλικό Υ1 

(τ.μ.) 

Υλικό Υ2 

(μ.μ.) 

1 A 20 --- 

2 B --- 500 

3 C 200 810 

4 D 35 --- 

5 E --- 700 

6 F 60 --- 

7 G --- 330 

8 H 80 --- 

9 I --- 650 

10 J 90 120 

11 K 150 --- 

12 L 30 430 

13 M --- 280 

 

Στον Πίνακα Ε παρουσιάζεται το εκτιμώμενο κατ’ αποκοπή κόστος πάγιων δαπανών (άμεσο κόστος) 

ανά δραστηριότητα, ανεξαρτήτως διάρκειας: 

Πίνακας Ε – Εκτιμώμενο απαιτούμενο κατ’ αποκοπή άμεσο κόστος ανά δραστηριότητα 

Α/Α Δραστηριότητα Πάγιο Κόστος (€) 

1 A 2.000,00 

2 B 3.500,00 

3 C 2.500,00 

4 D 6.200,00 

5 E 3.800,00 

6 F 2.300,00 

7 G 1.700,00 

8 H 2.400,00 

9 I 3.600,00 

10 J 2.100,00 

11 K 1.800,00 

12 L 2.700,00 

13 M 3.400,00 

 

Ζητούνται με χρήση του λογισμικού MS Project©: 

(α)  η αντιστοίχιση των πόρων των Πινάκων Β, Γ, Δ και Ε στις δραστηριότητες του έργου, 

(β) ο υπολογισμός του συνολικού προϋπολογισμού του έργου καθώς και του επιμέρους κόστους 

κάθε δραστηριότητας, 

(γ) τα διαγράμματα κατανομής των πόρων του έργου για τους ενωρίτερους χρόνους έναρξης των 

δραστηριοτήτων και 

(δ) σε περίπτωση που διαπιστωθούν υπεραπασχολήσεις των διαθέσιμων πόρων του έργου, να 

γίνει εξομάλυνση της κατανομής πόρων και αναπρογραμματισμός του έργου, χωρίς διάσπαση 

(splitting) των δραστηριοτήτων και με κριτήριο την ελάχιστη δυνατή συνολική διάρκειά του.  
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3.2. Αναλυτική Επίλυση Παραδείγματος #02: 

Στο Project υπάρχουν οι κάτωθι τρεις βασικές κατηγορίες πόρων:  

Πόρος εργασίας (Work resource) 

Το βασικό μέγεθος που εντάσσει έναν πόρο στην κατηγορία αυτή είναι η εξάρτησή του από το 

χρόνο. Οι πόροι εργασίας είναι όλοι οι πόροι, η συμμετοχή των οποίων στο έργο ελέγχεται μέσω 

του χρόνου. Παραδείγματα πόρων εργασίας αποτελούν το προσωπικό που αμείβεται ανάλογα με 

το χρόνο απασχόλησής του, ο εξοπλισμός που το κόστος χρήσης του είναι ανάλογο των ωρών 

λειτουργίας του για τις ανάγκες του έργου, κ.λπ. Το κόστος των πόρων εργασίας ορίζεται ανά 

χρονική μονάδα (π.χ., ώρες, εβδομάδες, κ.λπ.).  

Πόρος υλικού (Material resource) 

Στην κατηγορία αυτή ανήκουν οι πόροι που καταναλώνονται κατά την υλοποίηση του έργου, 

όπως π.χ., οι πρώτες ύλες, τα αναλώσιμα, κ.λπ. Οι πόροι υλικών επιδρούν στις διάρκειες των 

δραστηριοτήτων του έργου, μόνο στην περίπτωση που δεν είναι διαθέσιμοι και υπάρχει χρόνος 

αναμονής ώστε να υλοποιηθεί η παραγγελία και η παραλαβή τους. Το κόστος των πόρων υλικών 

ορίζεται ανά μονάδα μέτρησής τους, π.χ. το οπλισμένο σκυρόδεμα ανά κυβικό μέτρο, τα καλώδια 

ανά τρέχον μέτρο, οι διακόπτες ανά τεμάχιο, κ.λπ.  

Πόρος κόστους (Cost resource) 

Οι πόροι αυτής της κατηγορίας δεν συνδέονται άμεσα με τη συμμετοχή προσωπικού και υλικών 

που καταναλώνονται κατά την εκτέλεση μιας δραστηριότητας και, ως εκ τούτου, χρεώνονται κατ’ 

αποκοπή. Παραδείγματα πόρων κόστους είναι τα οδοιπορικά έξοδα, τα έξοδα επικοινωνίας, η 

εφάπαξ χρέωση μιας υπηρεσίας, κ.λπ.  

Προκειμένου να διευκολυνθεί ο σχεδιασμός του έργου, στο λογισμικό υπάρχει η έννοια του 

γενικευμένου πόρου (Generic resource). Ο ορισμός ενός πόρου ως γενικευμένου είναι πολύ 

χρήσιμος στην αρχική διαδικασία του σχεδιασμού ενός έργου, όπου το ζητούμενο είναι να βρεθεί 

η συνολική απαιτούμενη ποσότητα των πόρων ανά χρονική μονάδα, βάσει των επιμέρους 

απαιτήσεων των δραστηριοτήτων. Ο γενικευμένος πόρος συνήθως εγγράφεται με όνομα βάσει 

της κύριας ιδιότητας του και αυτό που τον διακρίνει από τον πραγματικό είναι ότι μπορεί να 

υπερφορτωθεί πέραν της μέγιστης διαθεσιμότητας. Για παράδειγμα, έστω ότι σε ένα έργο 

απαιτείται ένας εργάτης (Work resource). Εάν ορισθεί ο πόρος Εργάτης ως γενικευμένος και 

προκύψει ότι η απαίτηση χρήσης του για μια χρονική περίοδο είναι 300%, αυτό σημαίνει ότι κατά 

τη διάρκειά της πρέπει να απασχοληθούν πλήρως, τρεις (3) εργάτες. Είναι προφανές, ότι πριν την 

οριστικοποίηση του τελικού προγράμματος (Baseline) του έργου, στις δραστηριότητες που έχουν 

αντιστοιχιστεί γενικευμένοι πόροι πρέπει να γίνει εκ νέου αντιστοίχιση των πραγματικών πόρων. 

Για να εισάγουμε τους πόρους του έργου στο Project 2019, κάνουμε τα εξής:  

(i) Προβάλλουμε τον πίνακα εισαγωγής πόρων (Resource Sheet): View ► Resource Views ► 

Resource Sheet.  

 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

12 

(ii) Η στήλη γενικευμένων πόρων εμφανίζεται ως εξής: με δεξί κλικ πάνω στην επικεφαλίδα της 

επόμενης στήλης (Material Label) από αυτή στα δεξιά της οποίας θα τοποθετηθεί (Type) και στην 

καρτέλα που εμφανίζεται, επιλογή Insert Column, πληκτρολόγηση g για να φιλτραριστούν τα 

πεδία και επιλογή Generic.  

(iii) Με παρόμοιο τρόπο, μετά τη στήλη Max. Units προστίθεται η στήλη Peak, η χρησιμότητα της 

οποίας θα εξηγηθεί στη συνέχεια. Επομένως, ο πίνακας εισαγωγής πόρων περιλαμβάνει: 

 

Resource Name: Το όνομα του πόρου. Συνιστάται να τηρείται ένας προκαθορισμένος τρόπος 

ονοματολογίας. Π.χ. για ονόματα προσωπικού, πρώτα Επίθετο και στη συνέχεια αρχικό γράμμα 

ονόματος. Κόμματα (,) και αγκύλες ([ ]) δεν είναι αποδεκτά σύμβολα.  

Type: O τύπος του πόρου. Τρεις τιμές είναι αποδεκτές: Work, Material και Cost. Όμοια, οι τιμές 

μπορούν να εισαχθούν πληκτρολογώντας w, m ή c και πατώντας Enter.  

Generic: Εδώ, δηλώνεται εάν o πόρος είναι πραγματικός ή γενικευμένος. Επιτρέπονται μόνο δύο 

τιμές. Τιμή Yes για γενικευμένο και No για πραγματικό. Η εισαγωγή των τιμών εκτός από το drop 

down μενού, μπορεί να γίνει γρήγορα πληκτρολογώντας τα αρχικά των δύο επιλογών, ήτοι y ή n 

και πατώντας Enter. Εφόσον ένας πόρος δηλωθεί ως γενικευμένος στη στήλη Indicators (1η 

στήλη του πίνακα) εμφανίζεται ένα σύμβολο με δύο πρόσωπα.  

Material Label: Tα κελιά της στήλης είναι ενεργοποιημένα, μόνο εφόσον ο τύπος του πόρου είναι 

Material. Σε αυτή δηλώνεται η μονάδα μέτρησης του υλικού πόρου, π.χ., m3, λίτρο, τεμάχιο, κ.λπ.  

Initials: Μια συντομογραφία του πόρου, π.χ. αρχικά ονόματος. Η συντομογραφία χρησιμοποιείται 

αντί του πλήρους ονόματος στις περιπτώσεις που απαιτείται να μειωθούν τα πλάτη των στηλών, 

κ.λπ. Το πεδίο συμπληρώνεται αυτόματα με το πρώτο γράμμα του πλήρους ονόματος και αλλάζει 

εφόσον το επιθυμεί ο χρήστης.  

Group: Οι πόροι μπορούν να ομαδοποιηθούν σε ομάδες. Στη στήλη αυτή ορίζεται σε ποια ομάδα 

θα ανήκει ο πόρος. Η χρήση ομάδων διευκολύνει τις προβολές με φίλτρα, κ.λπ. Ο ορισμός και η 

προβολή ομάδων με εφαρμογή φίλτρων γίνεται από την καρτέλα View από τα drop down μενού  

Group by και Filter.  

Max. Units: Tα κελιά της στήλης αυτής είναι επίσης ενεργοποιημένα, μόνο εφόσον ο τύπος του 

πόρου είναι Work. Στη στήλη αυτή δηλώνεται το ποσοστό που αντιστοιχεί στη διαθεσιμότητα του 

κάθε πόρου για συμμετοχή στο έργο σε σχέση με το ημερολόγιο που αυτός ακολουθεί (στήλη 

Base Calendar). Για παράδειγμα, αν για έναν πόρο η τιμή είναι 100% και στο Base Calendar έχει 

δηλωθεί ημερολόγιο Standard σημαίνει ότι αυτός είναι διαθέσιμος να απασχοληθεί στο έργο 

πενθήμερο, οκτώ ώρες την ημέρα. Αντίστοιχα, η τιμή 50%, σημαίνει διαθεσιμότητα απασχόλησης 

τεσσάρων ωρών την ημέρα. Στην περίπτωση όμως που η τιμή είναι 100% και έχει δηλωθεί 

ημερολόγιο 24 Hours, ο πόρος είναι διαθέσιμος στο έργο χωρίς διακοπή. Τέλος, η τιμή 400% 

σημαίνει ότι ο διαθέσιμος αριθμός του εν λόγω πόρου είναι τετραπλάσιος της πλήρους 

διαθεσιμότητας, π.χ., τέσσερα όμοια μηχανήματα που θα δουλεύουν ταυτόχρονα.  

Peak: Η τιμή αυτού του κελιού υπολογίζεται αυτόματα όταν ο εν λόγω πόρος αντιστοιχιστεί στις 

δραστηριότητες του έργου και δείχνει τη μέγιστη τιμή (αιχμή) που ο πόρος απαιτείται να 

απασχοληθεί μια χρονική στιγμή κατά τη διάρκεια εκτέλεσης του έργου.  

Std. Rate (Standard rate): Το κόστος του πόρου ανά μονάδα ορισμού του. Αν ο πόρος είναι Work 

resource το κόστος δηλώνεται ανά χρονική μονάδα. Αν ο πόρος είναι Material resource, η τιμή 

εκφράζει το κόστος ανά μονάδα μέτρησης, όπως δηλώθηκε στη στήλη Material Label. Τέλος, αν ο 

πόρος είναι Cost resource η τιμή που δηλώνεται εκφράζει πραγματικό κόστος.  

Ovt. Rate (Overtime rate): Το κόστος της υπερωριακής απασχόλησης του πόρου ανά μονάδα 

χρόνου. Χρησιμοποιείται μόνο για Work resource πόρους.  



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

13 

Cost/Use (Cost per use): Το εφάπαξ κόστος χρήσης του πόρου κάθε φορά που χρησιμοποιείται. 

Η τιμή αυτή δεν σχετίζεται με τη δήλωση κόστους ενός πόρου τύπου Cost.  

Accrue At: Εδώ, δηλώνεται ποια χρονική τιμή χρεώνεται το έργο από τη χρήση του πόρου. Τρεις 

τιμές είναι αποδεκτές: Start και End για χρέωση στην έναρξη και τη λήξη της δραστηριότητας, 

αντίστοιχα, και Prorated για ισοκατανομή της χρέωσης στη διάρκεια της δραστηριότητας.  

Base Calendar: Tα κελιά της στήλης αυτής είναι ενεργοποιημένα, μόνο εφόσον ο τύπος του 

πόρου είναι Work. Στη στήλη αυτή δηλώνεται ποιο ημερολόγιο ακολουθεί κάθε πόρος.  

Code: Κωδικός του πόρου. Χρησιμοποιείται, όπως και το Resource Name και το Initials, για την 

ταυτοποίηση του πόρου.  

Οι πόροι του έργου του Παραδείγματος #02 ορίζονται εισάγοντας τα εβδομαδιαία κόστη του 

Εργάτη (ο οποίος ορίσθηκε ως Generic), των μηχανημάτων M1, M2 και M3 και των υλικών Y1 και 

Y2, στη στήλη Std. Rate, τους περιορισμούς διαθεσιμότητας των μηχανημάτων M1, M2 και M3 

στη στήλη Max. Units και τις μονάδες μέτρησης των υλικών Y1 και Y2 στη στήλη Material Label. 

Με την εισαγωγή των δεδομένων, η οθόνη του Project θα είναι παρόμοια με την ακόλουθη εικόνα: 

 

Το Πάγιο κόστος εισάγεται ως Material με (πλασματική) τιμή €1,00 ανά μονάδα μέτρησης και όχι 

ως πόρος Cost για την αποφυγή λανθασμένων αποτελεσμάτων από τη χρήση του λογισμικού 

στη συνέχεια (κατά τον έλεγχο προόδου του έργου). 

Η αντιστοίχιση των πόρων στις δραστηριότητες γίνεται από την καρτέλα διαλόγου Assign 

Resources. Για να προβληθεί, πρέπει πρώτα να έχουμε επιστρέψει σε προβολή Gantt Chart, 

αφού στο Resource Sheet το κουμπί που την ανοίγει είναι ανενεργό. Η προβολή της γίνεται από 

την καρτέλα Resource πατώντας το κουμπί Assign Resources. 
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Στην καρτέλα Assign Resources, στη στήλη Resource προβάλλονται όλοι οι δηλωθέντες πόροι. 

Όταν η καρτέλα διαλόγου Assign Resources ανοίξει, μπορεί να τοποθετηθεί σε μια θέση που δεν 

εμποδίζει και ο χρήστης να συνεχίσει να εργάζεται σε άλλα παράθυρα. Η καρτέλα σταματά να 

είναι ενεργή, αλλά δεν κλείνει, οπότε ο χρήστης μπορεί να συνεχίσει αργότερα σε αυτή χωρίς να 

χρειαστεί να την ξανανοίξει. Η καρτέλα κλείνει μόνο από το κουμπί Close που διαθέτει.  

Για να αντιστοιχιστεί ένας πόρος τύπου Work ή Material σε μια δραστηριότητα εκτελούνται οι 

παρακάτω ενέργειες, υποχρεωτικά με τη σειρά που περιγράφονται:  

1. Επιλέγεται η δραστηριότητα από τον πίνακα δραστηριοτήτων της προβολής Gantt Chart. 

2. Στην καρτέλα διαλόγου Assign Resources εισάγεται τιμή στο κελί της στήλης Units. Η φυσική 

σημασία των τιμών της στήλης Units εξαρτάται από το είδος του πόρου. Για πόρους τύπου Work, 

οι τιμές της στήλης Units εκφράζουν το ποσοστό του χρόνου που θα απασχοληθεί ο πόρος σε 

αυτή την δραστηριότητα σε σχέση με το ημερολόγιο που αυτός ακολουθεί (στήλη Base Calendar 

του Resource Sheet).  

Για πόρους τύπου Material οι τιμές της στήλης Units εκφράζουν το ποσό του απαιτούμενου 

υλικού για τη δραστηριότητα στη μονάδα μέτρησης που δηλώθηκε στη στήλη Material του 

Resource Sheet.  

Σε περίπτωση που για έναν πόρο το άθροισμα των δηλωθέντων ποσοστών/ποσών Units σε όλες 

τις δραστηριότητες που συμμετέχει οποιαδήποτε χρονική στιγμή, υπερβεί το ποσοστό/ποσό στη 

στήλη Max. Units του φύλλου εισαγωγής Resource Sheet, ο πόρος (εφόσον δεν είναι δηλωμένος 

ως Generic) υπερφορτώνεται/υπεραπασχολείται (overallocated).  

Όπως ήδη αναφέρθηκε, η μέγιστη τιμή (αιχμή) απασχόλησης του πόρου σε όλη τη διάρκεια 

συμμετοχής του καταγράφεται στη στήλη Peak του Resource Sheet. Για παράδειγμα, εάν για έναν 

πόρο δηλώθηκε Max. Units 50%, αυτό σημαίνει ότι ο πόρος αυτός, με Standard ημερολόγιο, θα 

απασχοληθεί 4 ώρες την ημέρα. Εάν για τη δραστηριότητα Α, ο πόρος δηλωθεί Units 10% και για 

τη Β Units 40%, αυτό σημαίνει ότι θα απασχοληθεί με τη μέγιστη διαθεσιμότητά του, ήτοι 4 ώρες, 

και θα απασχοληθεί 0,8 ώρες στην Α και 3,2 ώρες στη Β (10% + 40% = 50%).  

Για παράδειγμα, για τη δραστηριότητα Α του Παραδείγματος #02, απαιτούνται δύο (2) εργάτες 

πλήρους απασχόλησης ανά εβδομάδα, οπότε θα συμπληρωθεί 200% (παρότι ισχύει Max. Units 

100%, διότι ο πόρος Εργάτης δηλώθηκε ως Generic).  

Επίσης, απαιτούνται δύο (2) μηχανήματα M1, ένα (1) μηχάνημα Μ2 και ένα (1) μηχάνημα Μ3, για 

πλήρη απασχόληση ανά εβδομάδα, οπότε θα συμπληρωθούν στη στήλη Units 200%, 100% και 

100%, αντίστοιχα.  

Ακόμη, απαιτούνται 20 τ.μ. από το υλικό Υ1, οπότε θα συμπληρωθεί η ποσότητα 20 στη στήλη 

Units.  

Τέλος, συμπληρώνεται, επίσης στη στήλη Units, η πλασματική ποσότητα 2.000,00 ως το κατ’ 

αποκοπή άμεσο κόστος της δραστηριότητας Α. 

3. Κλικ στο κουμπί Assign. Εναλλακτικά, μπορεί να γίνει κλικ σε οποιοδήποτε άλλο κελί.  

Αμέσως μετά την αντιστοίχιση, στη στήλη αριστερά της Resource Name εμφανίζεται ένα (√) που 

υποδηλώνει ότι ο πόρος είναι αντιστοιχισμένος στην επιλεγμένη δραστηριότητα. Με αυτόν τον 

τρόπο, τα (√) απεικονίζουν ποιοι πόροι είναι αντιστοιχισμένοι στην επιλεγμένη δραστηριότητα.  

Επίσης, συμπληρώνεται αυτόματα η στήλη Cost, βάσει των τιμών της στήλης Std. Cost του 

Resource Sheet.  

Εκτελώντας την προαναφερθείσα διαδικασία για κάθε δραστηριότητα του έργου, η καρτέλα 

Assign Resources συμπληρώνεται ως εξής: 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

15 

 

 

 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

16 

 

 

 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

17 

 

 

 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

18 

 

 

 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

19 

 

Πατώντας το πλήκτρο Assign γίνεται η αντιστοίχιση. Το Project θεωρεί ότι αυτή ολοκληρώθηκε και 

η επιλογή απενεργοποιείται. Η πρώτη αυτή αντιστοίχιση θεωρείται ως αντιστοίχιση αναφοράς και 

στην περίπτωση που ο χρήστης εκτελέσει ξανά τη διαδικασία αλλάζοντας κάποια από τις τιμές 

στα κελιά της στήλης Units, πατώντας για δεύτερη φορά το κουμπί Assign, το Project θεωρεί, ως 

προεπιλογή, ότι ο συνολικός φόρτος (Work) που απαιτείται για την εκτέλεση της δραστηριότητας 

παραμένει σταθερός, έτσι όπως τον υπολόγισε από την αντιστοίχιση αναφοράς βάσει της σχέσης:  

Work = Units x Duration    (W = U x D) (1) 

και αυξομειώνει αυτόματα τη διάρκεια. Το ίδιο ακριβώς θα γίνει εάν ο χρήστης, αφού έχει γίνει 

η αντιστοίχιση, αλλάξει τη διάρκεια της δραστηριότητας. Η τιμή Units του πόρου θα προσαρμοστεί 

κατάλληλα ώστε να παραμείνει σταθερός ο φόρτος. Προφανώς, μέσω τον παραπάνω αλλαγών, ο 

χρήστης μπορεί να υλοποιήσει σενάρια επιτάχυνσης ή μείωσης του κόστους του έργου. Εάν δεν 

εφαρμόζονται τα προαναφερθέντα σενάρια, πρέπει αμέσως μετά τη νέα αντιστοίχιση να πατηθεί 

το σύμβολο με το κίτρινο φόντο και το μαύρο θαυμαστικό στη στήλη Task Name και στην καρτέλα 

που ανοίγει να επιλεχθεί Increase the amount of work but keep the same duration. 

 

Σε περίπτωση που μειωθεί η διάρκεια μιας δραστηριότητας στην οποία έχουν ήδη αντιστοιχιστεί 

πόροι, χωρίς να εφαρμόζονται σενάρια επιτάχυνσης ή μείωσης του κόστους, πρέπει αμέσως μετά 

την αλλαγή (η οποία ουσιαστικά λαμβάνεται ως νέα αντιστοίχιση) να πατηθεί το σχετικό σύμβολο 

(δηλ. κίτρινος ρόμβος με μαύρο θαυμαστικό) στη στήλη Duration αυτή τη φορά (και όχι στη στήλη 

Task Name) και στην καρτέλα που ανοίγει να επιλεχθεί Increase the hours resources work per 

day (units) but keep the same amount of work (η επιλογή αυτή δεν είναι η προεπιλεγμένη). 
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Παρόμοιο με το πρώτο από τα ως άνω μηνύματα (σελ. 19) εμφανίζεται και όταν αντιστοιχίζονται 

παραπάνω από ένας πόροι στην ίδια δραστηριότητα. Στην περίπτωση αυτή, το μήνυμα έχει ως 

προεπιλογή να αυξηθεί ο φόρτος και να παραμείνει ίδια η διάρκεια, οπότε απλά αγνοείται. Κάθε 

φορά που πραγματοποιείται μια νέα αντιστοίχιση, τίθεται αυτή ως η αντιστοίχιση αναφοράς για 

τον υπολογισμό των μεγεθών βάσει της σχέσης (1).  

Επιλέγοντας την προβολή Task Sheet από την καρτέλα View, η οθόνη του Project γίνεται: 

 

Το σύμβολο με το κόκκινο ανθρωπάκι στη στήλη Indicators υποδηλώνει ότι στο έργο υπάρχουν 

υπερφορτωμένοι πόροι. Προφανώς, αφού ο πόρος Εργάτης έχει δηλωθεί ως Generic, το σύνολο 

των δραστηριοτήτων εμφανίζει υπεραπασχόληση πόρων. Επίσης, από την προβολή Gantt Chart 

και κατόπιν επιλογής όλων των δραστηριοτήτων με δεξί κλικ στο κατάλληλο πλήκτρο και, εν 

συνεχεία, επιλέγοντας τον πίνακα Cost (αριστερά και ακριβώς πάνω από τη στήλη αρίθμησης 

των δραστηριοτήτων, βλ. κάτωθι εικόνα), προκύπτει το συνολικό κόστος του έργου, €513.800, 

καθώς και το κόστος κάθε δραστηριότητας: 

 

Ο έλεγχος αντιστοίχισης δραστηριοτήτων και πόρων μπορεί να γίνει μέσω διάφορων διαθέσιμων 

προβολών, είτε πατώντας στο βελάκι (κάτω δεξιά) του κουμπιού Gantt Chart (άνω αριστερά) στο 

Ribbon μενού ή με δεξί κλικ στην αριστερή μπάρα προβολής (View Bar) και κατάλληλη επιλογή.  

Στη συνέχεια, παρουσιάζονται κάποιες από τις πιο σημαντικές προβολές. 



Οδηγός Χρήσης MS Project 2019® 

Δρ. Δημήτριος Δ. Καντιάνης, Μέλος Ε.ΔΙ.Π. 

21 

Προβολή Task Form (επιλογή Schedule, είτε από το βασικό μενού ή με δεξί κλικ, βλ. εικόνα): 

 

Προβολή Task Form (επιλογή Cost, ομοίως με ανωτέρω, εδώ με επιλογή από το βασικό μενού): 

 

Προβολή Task Usage (επιλογή Work από την καρτέλα Format): 
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Από την ανωτέρω προβολή προκύπτει ότι, π.χ. για τη δραστηριότητα D, απαιτούνται 90 εργατο-

εβδομάδες, 10 εβδομάδες πλήρους λειτουργίας του μηχανήματος M2 και 20 εβδομάδες πλήρους 

απασχόλησης του μηχανήματος Μ3. Οι 90 εργατο-εβδομάδες κατανέμονται ομοιόμορφα σε όλη 

τη διάρκεια των 10 εβδομάδων εκτέλεσης της δραστηριότητας και, ως εκ τούτου, λαμβάνοντας 

υπόψη ότι μία ημέρα δραστηριότητας αντιστοιχεί σε (1/5) = 0,2 εβδομάδες, η ημερήσια απαίτηση 

είναι (90/10) × 0,2 = 1,8 εργατο-εβδομάδες (1,8w). 

Προβολή Resource Sheet: 

Μετά την αντιστοίχιση των πόρων στις δραστηριότητες, η προβολή Resource Sheet αλλάζει σε: 

 

Η κόκκινη έντονη μορφοποίηση στις γραμμές κάποιων πόρων υποδηλώνει ότι οι πόροι αυτοί 

υπερφορτώνονται (μηχανήματα Μ1, Μ2, Μ3 και Εργάτης). Στη στήλη πληροφοριών εμφανίζεται 

το σύμβολο της υπεραπασχόλησης (κόκκινο ανθρωπάκι). Ο πόρος Εργάτης, παρότι είναι επίσης 

μορφοποιημένος σαν να υπερφορτώνεται, έχει ήδη δηλωθεί ως Generic και άρα δεν θεωρείται ότι 

υπεραπασχολείται. Στη στήλη Peak προβάλλονται οι μέγιστες τιμές της ζήτησης. Από τις τιμές 

αυτές προκύπτει ότι:  

• Ο μέγιστος αριθμός των απαιτούμενων Εργατών για την εκτέλεση των δραστηριοτήτων είναι 

11 (ή αλλιώς 1.100%).  

• Το μηχάνημα Μ1 υπερφορτώνεται κατά 200% (από την τιμή της στήλης Peak αφαιρείται η τιμή 

της στήλης Max. Units, δηλ. 500% – 300% = 200%), συνεπώς με το παρόν χρονοδιάγραμμα 

απαιτούνται δύο (2) επιπλέον μηχανήματα Μ1 για να είναι δυνατή η απρόσκοπτη εκτέλεση του 

έργου σύμφωνα με τον αρχικό σχεδιασμό του.  

• Ομοίως, κάθε ένα από τα μηχανήματα Μ2 και Μ3 υπερφορτώνεται κατά 100% (400% – 300% 

= 100% και 300% – 200% = 100%, αντίστοιχα). Επομένως, απαιτούνται από ένα (1) επιπλέον 

μηχάνημα Μ1 και μηχάνημα Μ2. 

Από τα παραπάνω συνάγεται ότι το χρονοδιάγραμμα χρειάζεται εξομάλυνση (leveling) ώστε να 

ικανοποιούνται οι περιορισμοί των πόρων. 

Τέλος, προκειμένου ο πόρος Εργάτης να μην εμφανίζεται με κόκκινη επισήμανση, αντικαθίσταται 

η τιμή 100% της στήλης Max. Units από την τιμή 1.100% της στήλης Peak. Με τον τρόπο αυτό, οι 

διαθέσιμοι εργάτες είναι όσοι ακριβώς απαιτούνται (δηλ. συνολικά 11 εργάτες): 
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Προβολή Resource Form (επιλογή Cost από την καρτέλα Format): 

 

Προβολή Resource Usage (επιλογή Work από την καρτέλα Format): 
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Προβολή Resource Graph: 

Μέσω της Resource Graph είναι δυνατή η προβολή διαγραμμάτων κατανομής διάφορων μεγεθών 

ως συνάρτηση του χρόνου εκτέλεσης του έργου. Η επιλογή πόρου γίνεται με κύλιση της ροδέλας 

του mouse και η επιλογή μεγεθών με δεξί κλικ στην επιφάνεια του διαγράμματος.  

Τα κυριότερα από τα διαγράμματα που μπορεί να προβληθούν είναι το διάγραμμα κατανομής 

πόρου στο χρόνο (Peak Units), η κατανομή κόστους για κάθε πόρο στο χρόνο (Cost) και η 

καμπύλη αθροιστικού κόστους (Cumulative Cost).  

Στη συνέχεια, παρουσιάζονται τα διαγράμματα κατανομής πόρων για τον Εργάτη, για τα μηχανήματα 

Μ1, Μ2 και Μ3 και για τα υλικά Υ1 και Υ2, καθώς και τα διαγράμματα κατανομής του παγίου κόστους. 

Στο κάτω μέρος των διαγραμμάτων προβάλλονται οι μέγιστες τιμές ανά χρονική περίοδο.  
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Αναπρογραμματισμός του έργου λόγω περιορισμού στους διαθέσιμους πόρους 

Προκειμένου να ικανοποιηθούν οι περιορισμοί στη διαθεσιμότητα των πόρων, το Project δίνει τη 

δυνατότητα αναπρογραμματισμού του χρονοδιαγράμματος, μετακινώντας τις δραστηριότητες στα 

ελεύθερα και στα ολικά περιθώρια τους και, εφόσον απαιτείται, αυξάνοντας τη συνολική διάρκεια 

του έργου. Εναλλακτικά, μπορεί να διακοπεί η εκτέλεση μιας εργασίας για ένα διάστημα (splitting) 

και να συνεχιστεί όταν υπάρχουν διαθέσιμοι πόροι. Υπάρχουν 3 τρόποι επαναπρογραμματισμού: 

• Ο αυτόματος, όπου το Project μετακινεί αυτόματα όλες τις δραστηριότητες.  

• Ο ημιαυτόματος, όπου ο χρήστης επιλέγει τις δραστηριότητες που θα μετακινηθούν και το 

πρόγραμμα τις μετακινεί έτσι ώστε να επιτευχθεί το βέλτιστο αποτέλεσμα.  

• Ο χειροκίνητος, όπου ο χρήστης δηλώνει απευθείας τη νέα ημερομηνία εκτέλεσης της 

δραστηριότητας.  
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Προκειμένου να είναι ορατά τα αποτελέσματα, επιλέγεται Leveling Gantt από το drop down μενού More 

Views της καρτέλας View (με κλικ στο Apply). Στην προβολή Leveling Gantt προστίθεται αυτόματα η 

στήλη Leveling Delay με τις καθυστερήσεις έναρξης όταν οι μετακινήσεις γίνονται αυτόματα. 

 

Οι παράμετροι του αυτόματου αναπρογραμματισμού των δραστηριοτήτων ρυθμίζονται από το 

μενού Resource και πατώντας το κουμπί Leveling Options για να ενεργοποιηθεί το παράθυρο 

διαλόγου Resource Leveling. Όταν οι αρχικές παράμετροι τροποποιηθούν, οι νέες τιμές τους 

διατηρούνται και στα επόμενα έργα. Οι παράμετροι αυτές περιγράφονται ως εξής: 
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Automatic ή Manual (υπολογισμοί): η χειροκίνητη επιλογή (συνιστάται) σημαίνει ότι ο χρήστης 

επιλέγει πότε θα γίνει αναπρογραμματισμός. Εναλλακτικά, επιλέγεται η αυτόματη εξισορρόπηση. 

Επιλογή της χρονικής βάσης αναζήτησης υπεραπασχολήσεων: Day by Day ή Week by Week ή 

Month by Month, κ.λπ.  

Clear leveling values before leveling: όταν η παράμετρος αυτή είναι επιλεγμένη, το πρόγραμμα, 

πριν από κάθε επαναπρογραμματισμό, διαγράφει τυχόν προηγούμενους, είτε χειροκίνητους είτε 

αυτόματους. Συνίσταται η επιλογή να είναι απενεργοποιημένη και η διαγραφή προηγούμενων 

επαναπρογραμματισμών να γίνεται χειροκίνητα από το χρήστη.  

Leveling range: εδώ δηλώνεται εάν ο αναπρογραμματισμός θα αφορά ολόκληρο το έργο (Level 

entire project) ή ένα μέρος του, μεταξύ μιας χρονικής περιόδου που ορίζεται από το χρήστη. 

Leveling order: εδώ καθορίζεται η σειρά βάσει της οποίας γίνεται ο αναπρογραμματισμός των 

δραστηριοτήτων. Η σειρά καθορίζεται από την προτεραιότητα (Priority) κάθε δραστηριότητας. Ως 

προεπιλογή, όλες οι δραστηριότητες έχουν την ίδια προτεραιότητα (Standard) και αυτή η έννοια 

δεν συνδέεται με το εάν η δραστηριότητα είναι κρίσιμη ή όχι. Για να αλλαχθεί η προτεραιότητα των 

δραστηριοτήτων, προστίθεται η στήλη Priority. Αρχικά όλες οι τιμές είναι 500. Δίνοντας τιμές από 

0 έως 1000, μπορεί να καθοριστεί συγκριτικά η προτεραιότητα της κάθε δραστηριότητας σε σχέση 

με τις υπόλοιπες.  

 

Level only within available slack: εδώ δηλώνεται εάν θα μετακινηθούν οι δραστηριότητες μόνο 

μέσα στα περιθώρια τους, ήτοι δεν θα αυξηθεί η χρονική διάρκεια του έργου. Προφανώς, εάν το 

πεδίο αυτό είναι ενεργό, υπάρχει περίπτωση να μη είναι δυνατή η επίλυση του προβλήματος.  

Leveling can adjust individual assignments on a task: οι πόροι που αντιστοιχίζονται σε μια 

δραστηριότητα μπορεί να συνδέονται για να εκτελεσθεί η δραστηριότητα. Σε περίπτωση που 

χρειάζεται αναπρογραμματισμό κάποιος από αυτούς, θα πρέπει να αναπρογραμματισθούν και οι 

συνεργαζόμενοι πόροι. Ενεργοποίηση της επιλογής υποδηλώνει ανεξαρτησία των πόρων, έτσι 

ώστε η εξισορρόπηση του ενός να μην επηρεάζει τους άλλους.  
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Leveling can create splits in remaining work: όταν η επιλογή είναι ενεργή, δίνεται η δυνατότητα 

επαναπρογραμματισμού με διάσπαση δραστηριοτήτων (splitting).  

Level resources with the proposed booking type: ενεργοποίηση της επιλογής δηλώνει ότι, η 

εξισορρόπηση αφορά τόσο τους πραγματικά διαθέσιμους πόρους όσο και τους προτεινόμενους 

(proposed booking type), ήτοι αυτούς που θέλουμε να χρησιμοποιήσουμε και τους λαμβάνουμε 

υπόψη στο στάδιο του σχεδιασμού αλλά δεν είναι εξασφαλισμένη η χρήση τους.  

Level manually scheduled tasks: όταν η επιλογή είναι ενεργή, ο αναπρογραμματισμός θα αφορά 

και τις δραστηριότητες οι οποίες έχουν προγραμματισθεί χειροκίνητα.  

Αυτόματος αναπρογραμματισμός 

Ο αυτόματος αναπρογραμματισμός γίνεται πατώντας το κουμπί Level All. Με εφαρμογή της 

διαδικασίας αυτής για το έργο, με τις ανωτέρω επιλεγμένες τιμές των παραμέτρων της καρτέλας 

Resource Leveling (σελ. 27), προκύπτουν τα κάτωθι αποτελέσματα: 

 

Η διάρκεια του έργου αυξήθηκε από 46 εβδομάδες σε 54 εβδομάδες. Εάν επαναληφθεί η 

διαδικασία, επιτρέποντας μόνο μετακινήσεις δραστηριοτήτων εντός των περιθωρίων τους, τότε το 

πρόβλημα δε μπορεί να επιλυθεί και το Project εμφανίζει το κάτωθι μήνυμα: 

 

Ημιαυτόματος αναπρογραμματισμός 

Ο αυτόματος αναπρογραμματισμός δεν οδηγεί πάντοτε στο βέλτιστο αποτέλεσμα και συχνά είναι 

αναγκαίο η διαδικασία να εκτελεστεί ημιαυτόματα. Συνήθως, τα αποτελέσματα της ημιαυτόματης 

διαδικασίας εξαρτώνται από τη σειρά των δραστηριοτήτων που αναπρογραμματίζονται. Γενικά, 

μετακινούνται πρώτα οι δραστηριότητες που έχουν μεγάλα ελεύθερα περιθώρια. Επιλέγεται η 

προβολή Detail Gantt όπου στη στήλη πληροφοριών εμφανίζονται με κόκκινο ανθρωπάκι οι 

υπερφορτωμένες δραστηριότητες. Συνιστάται να προστεθούν στην προβολή και οι στήλες Free 

Slack και Total Slack (με δεξί κλικ και εισαγωγή). Τέλος, δεξί κλικ στη στήλη των πληροφοριών 

και επιλογή Fix in Task Inspector ► Repair Options ► Reschedule Task. 
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Εάν γίνει η διαδικασία αυτή, κατά σειρά, για τις δραστηριότητες C, F, J και G, τότε επιλύεται το 

πρόβλημα ικανοποίησης των περιορισμών διαθεσιμότητας των μηχανημάτων M1, M2 και M3, με 

αύξηση της διάρκειας του έργου από 46 σε 55 εβδομάδες. 

 

Χειροκίνητος αναπρογραμματισμός 

Η μετακίνηση δραστηριοτήτων χειροκίνητα γίνεται, αφού πρώτα γίνει η επιλογή τους, από την 

καρτέλα Task και από το drop down μενού Move. Στο μενού αυτό υπάρχουν επιλογές 

μετακίνησης μιας ημέρας, μιας εβδομάδας και ενός μήνα (τεσσάρων εβδομάδων). Εάν απαιτείται 

κάποιο άλλο διάστημα, επιλέγεται το πεδίο Custom στο υπομενού Move Task Forward και στο 

σχετικό αναδυόμενο παράθυρο (Move tasks forward) συμπληρώνεται το επιθυμητό διάστημα 

μετακίνησης σε εργάσιμες ημέρες (working days). 

Εφόσον τα αποτελέσματα του αναπρογραμματισμού δεν είναι τα επιθυμητά, μπορούν άμεσα να 

αναιρεθούν με Undo. Οποιαδήποτε στιγμή, μπορούν να αναιρεθούν από την καρτέλα Resource 

και από το κουμπί Clear Leveling. 
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Συνιστάται πριν από προσπάθειες αναπρογραμματισμού να δημιουργείται αντίγραφο ασφαλείας 

του βασικού αρχείου του έργου.  
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4. Έλεγχος Προόδου Έργου (Ανάλυση Κερδισμένης Αξίας) 

4.1. Παράδειγμα #03: 

Σύμφωνα με τα αρχικά δεδομένα του Παραδείγματος #01, τους περιορισμούς διαθεσιμότητας των 

πόρων και τον (αυτόματο) αναπρογραμματισμό (εξομάλυνση πόρων δραστηριοτήτων) του έργου 

στο Παράδειγμα #02, καταρτίσθηκε το Πρόγραμμα Υλοποίησης (Baseline) βάσει των ενωρίτερων 

χρόνων έναρξης των δραστηριοτήτων.  

Το έργο προγραμματίσθηκε να διαρκέσει 54 εβδομάδες, με ημερομηνία έναρξης την 03/01/2022 

και ημερομηνία λήξης την 13/01/2023.  

Έστω ότι το έργο βρίσκεται στο στάδιο της υλοποίησης και συγκεκριμένα στο τέλος της 18ης 

εβδομάδας, η οποία αντιστοιχεί στην ημερομηνία 06/05/2022. Στον Πίνακα ΣΤ, παρατίθενται τα 

ποσοστά ολοκλήρωσης των δραστηριοτήτων στο τέλος της 18ης εβδομάδας.  

Να γίνει ο έλεγχος προόδου του έργου με τη μέθοδο της κερδισμένης (ή αλλιώς παραχθείσας ή 

δεδουλευμένης) αξίας με χρήση του λογισμικού MS Project 2019©. 

Πίνακας ΣΤ – Πρόοδος ολοκλήρωσης των δραστηριοτήτων στο τέλος της 18ης εβδομάδας 

Α/Α Δραστηριότητα 
Πραγματική 

Έναρξη 

Πραγματική 

Λήξη 

Πραγματική 

Διάρκεια 

(εβδομάδες) 

Ποσοστό 

Ολοκλήρωσης 

(%) 

 

Παρατηρήσεις 

1 A 03/01/2022 21/01/2022 
 
3 
 

100 

 
Έναρξη και λήξη βάσει 

προγραμματισμού. 
 

2 B 31/01/2022 18/02/2022 3 100 

 
Έναρξη 1 εβδομάδα 

αργότερα. Λήξη βάσει 
προγραμματισμού. 

 

3 C 02/05/2022 --- --- 25 

 
Έναρξη βάσει 

προγραμματισμού.        
Σε εξέλιξη. 

 

4 D 07/03/2022 --- --- 70 

 
Έναρξη 2 εβδομάδες 
αργότερα. Σε εξέλιξη. 

 

5 E --- --- --- 0 Δεν έχει ξεκινήσει. 

6 F --- --- --- 0 Δεν έχει ξεκινήσει. 

7 G --- --- --- 0 Δεν έχει ξεκινήσει. 

8 H --- --- --- 0 Δεν έχει ξεκινήσει. 

9 Ι --- --- --- 0 Δεν έχει ξεκινήσει. 

10 J --- --- --- 0 Δεν έχει ξεκινήσει. 

11 K --- --- --- 0 Δεν έχει ξεκινήσει. 

12 L --- --- --- 0 Δεν έχει ξεκινήσει. 

13 M --- --- --- 0 Δεν έχει ξεκινήσει. 
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4.2. Αναλυτική Επίλυση Παραδείγματος #03: 

Η οριστικοποίηση του τελικού προγράμματος υλοποίησης με όλες τις αναγκαίες πληροφορίες για τον 

προγραμματισμό του έργου, γίνεται με την επιλογή Set Baseline. Ουσιαστικά, η Baseline αποτελεί ένα 

αντίγραφο αναφοράς όλων των μεγεθών (baseline fields) του προγραμματισμού ώστε να υπάρχει 

δυνατότητα σύγκρισης των πραγματικών μεγεθών (actual fields) και αυτών που θα υπολογισθούν, 

βάσει των πραγματικών, για να προβλέψουν την εξέλιξη του έργου (scheduled fields). Στην καρτέλα 

Project και στο μενού Set Baseline επιλέγεται Set Baseline ► Entire project ► ΟΚ. 

 

Η ημερομηνία ελέγχου 06/05/2022 (Status Date) εισάγεται από την καρτέλα Project ► Status Date ► ΟΚ. 

 

Για εισαγωγή της πραγματικής προόδου έργου, από το κουμπί Gantt Chart επιλέγεται Tracking Gantt. 
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Στη συνέχεια, αφού προηγουμένως γίνει επιλογή όλων των δραστηριοτήτων, επιλέγεται Tracking. 

 

Έτσι, εμφανίζεται ο κάτωθι πίνακας εισαγωγής των πραγματικών δεδομένων της προόδου του έργου: 

 

Στις στήλες Act. Start και Act. Finish συμπληρώνονται οι ημερομηνίες πραγματικής έναρξης και 

λήξης των δραστηριοτήτων, εφόσον έχουν συμβεί. Στην επόμενη στήλη % Comp. συμπληρώνεται 

το ποσοστό ολοκλήρωσης. Εισάγοντας τα δεδομένα του Πίνακα ΣΤ της σελ. 32, η οθόνη του 

Project θα είναι παρόμοια με την ακόλουθη εικόνα: 
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Η προβολή των ποσοστών ολοκλήρωσης στο διάγραμμα Gantt ρυθμίζεται από την καρτέλα 

FORMAT, στο Gantt Chart Style, όπου πατώντας το δεξί κάτω βελάκι εμφανίζεται η καρτέλα Bar 

Styles. Στην καρτέλα Bar Styles επιλέγεται η γραμμή Task και στο πεδίο Right επιλέγεται % 

Complete (από το drop down μενού). 

Η κόκκινη συνεχής γραμμή στο διάγραμμα Gantt δείχνει τη Status Date. Για να προβληθεί, γίνεται 

δεξί κλικ στην επιφάνεια του διαγράμματος και στην καρτέλα που εμφανίζεται επιλέγεται το 

Gridlines. Στη νέα καρτέλα, στο πεδίο Line to change: επιλέγεται Status Date και ρυθμίζονται 

αναλόγως Type και Color. 

 

Με εφαρμογή της ανάλυσης κερδισμένης αξίας (earned value analysis), το Project υπολογίζει τις 

καμπύλες BCWS (Budgeted Cost for Work Scheduled), BCWP (Budgeted Cost for Work 

Performed), ACWP (Actual Cost for Work Performed) και τους δείκτες SV (Schedule Variance) 

και CV (Cost Variance).  

Η προβολή των ανωτέρω τιμών γίνεται, είτε μέσω της προβολής των πινάκων Earned Value, 

Earned Value Cost Indicators και Earned Value Schedule Indicators, είτε μέσω του γραφήματος 

Earned Value Over Time Report.  

Για την προβολή των πινάκων, αφού πρώτα γίνει επιλογή όλων των δραστηριοτήτων, επιλέγεται 

More Tables και στην καρτέλα που εμφανίζεται, επιλέγεται ένα από τα Earned Value, Earned 

Value Cost Indicators ή Earned Value Schedule Indicators. 

 

Με βάση την πρόοδο του έργου του παραδείγματος, οι τρεις πίνακες έχουν την ακόλουθη μορφή: 
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Για να προβληθεί το γράφημα Earned Value Over Time Report, από την καρτέλα Report και το 

μενού Export, επιλογή Visual Reports και στο αναδυόμενο παράθυρο (Visual Reports - Create 

Report) στο πεδίο Select Template επιλέγεται All ► Earned Value Over Time Report ► View. 
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